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Introduction
As one of the most used presentation tools in the world, it is little surprise that a new version
of Microsoft Office PowerPoint is an exciting proposition. Having practically sealed the
death of the overhead projector with its simple to use and versatile system of online slides
that offer a wide range of options, PowerPoint has gone from strength to strength, and the
new version is a logical improvement on what was already a capable and useful system.
PowerPoint is not just a replacement for the old tried and tested presentation methods that
businesses have relied on in the past, however. There is much more to it than the simple
aspects you see in the first instance. The original and useful creation of pages, changing
styles, slide shows and more are all there, but what is fresh about the new version of
PowerPoint is that it allows a much broader scope for video and image editing, something
that adds to the already versatile aspects of the system.
In addition, like all parts of the new Office10 package, the major change has been the
introduction of a web based version. This has been requested by users for some time now and
is a welcome improvement over the original, while the added advantage of a live sharing
function is also a plus point. Let’s have a look at some of these new details in close up.
Starting with the browser based version, (and this is perhaps the over-riding major change of
the new Office 10 package) this is a massive diversion from the old version. As with Word
and Excel, the ability to share files on the browser opens up a whole new area of use, and the
versatility of the system is not to be underestimated.
The advent of powerful smart phones is one reason why this is such an exciting feature, for
there is scope for viewing and checking slides on the browser of an internet phone, a function
that is useful to those on the move. Sharing files is easy – simply email it to users with a link
to the web version of the document. It is not difficult to see how this broadens the horizons
that PowerPoint can cope with.
The simplicity of creating a set of slides in the desktop version of the package and then
publishing it to the browser version means that sharing is as easy as it can possibly be.
The video editing system is also simple to use and adds a great deal of scope to the package
as a result. If you have ever used the iMovie package you will be familiar with the way this
system works, as it is very similar. Basically, selecting the editing function brings up an
additional screen upon which the editing is performed – as per the image below:

Editing is quick, simple and effective. Video editing is not, however, operable via the web
based version of PowerPoint 10, hence any amendments will need to be done within the
desktop and then uploaded.
The image editor is a similar system that resembles a number of well know editing systems in
a more basic form, and is also a useful addition to an already capable system.
Perhaps the most impressive of the new features is the live sharing function that enables
many people to view the same set of files, in real time, simultaneously; think of it as a sort of
video conferencing tool on the move and you begin to see where the benefits of these new
developments come into play.
The ability to include videos that you upload from your personal files, thus alleviating the
complexities of creating them from scratch, and any that you may have uploaded to websites
is also a neat feature of the new PowerPoint system. In fact, a default setting means that
embedding videos from your files is now done automatically, with no need for extra
management of files and added complexities when using the sharing functions.
Audio files also receive the full editing treatment that is provided by PowerPoint 10, with the
ability to import and edit as required without any complex methods or need to manage
separate files.
All in all, the new version of PowerPoint is a logical step forward that uses the web based
system to enhance one of the most powerful tools the business or academic user has at their
fingertips, and we can point in particular to the editing and sharing functions as those that are
of special interest.

Chapter 1: Basic Features
As with many such packages, the full scope of PowerPoint is rarely utilised by frequent users,
the trend being to operate the simple systems that provide the basic features, such as those
that are most frequently of use. This doesn’t mean that the more advanced features are of
little use, but that they are more often than not under-used.
Creating a slide:
Looking at the basic features of PowerPoint, let’s start with creating a simple slide.
Opening the PowerPoint screen brings us to the starting point, and it looks like this:

That is the basic beginners point for creating a slide.
Let’s say we want to create an opening page, titled ‘An Introduction to PowerPoint 10’ and
with the subtitle ‘Basic Features’. We click on the area where it says ‘Click to add title’ and
type in our title, then click on the second area and add our subtitle, click to complete and we
now have the following:

If we now save that slide, using the Office button as standard, we can then recover it later
when we want to use it.
Adding more slides:
Now that we have the opening slide we need to create the next one; click on ‘New Slide’ –
there on the menu across the top – and you will be given another blank slide as before, with
the additional one being added to the list of slides on the left hand side of the screen.
This is the most basic and simple aspect of PowerPoint – creating slides that go together to
become a presentation in the easiest possible manner.
Layouts:
You will have noticed that we have yet to move from the ‘Home’ tab. Also in this section we
can find functions that allow us to select a range of different layouts, a collection of shapes,
and a number of useful functions including the find and replace system at the right hand side
and the copy, paste and cut functions that are available on the left. All of these can be used in
the most basic forms to create and amend slides, and are the bedrock of the package.
Move to the ‘Insert’ tab, and the real scope of PowerPoint becomes clearer. Across the top
you will see a selection of options, among them those for adding tables plus pictures, clip art
and more. Let’s have a look at the pictures option.
Pictures:
Click the icon and it will take you immediately to your pictures folder in Desktop. This
allows you to select any picture you wish from that collection and insert it into the slide. I
have selected a scan of an old postcard as an example, and inserted it into our slide like this:

As you can see it is central to the page, but we can move it to the foot of the slide or
anywhere we wish by simply dragging it around the page. There are many options in this
section – the use of clip art is one that gives much in the way of customization and the use of
a photo album means you can create a full slide show of pictures – that are useful to the
presenter, and the system is very easy to use, too. The Insert tab also allows for the inserting
of text, charts and more, and the inclusion of sound and video from relevant files as required.
Standard Designs:
The ‘Design’ tab is one that allows for many different fonts and styles to be introduced into
the slide. Select the icon and you will be given a number of options, and clicking on each of
them with our basic slide open will give you an idea of the different options available. As
with many aspects of PowerPoint these are simply standard options and creating your own
versions is also a possibility. To the right of the several design options are buttons for
choosing colors, fonts and effects, giving you great scope for customized pages that are
unique to your presentation.
Animations:
The ‘Animations’ tab gives the option to select different fade in and fade out techniques
between the various slides, thus enhancing the impact of the presentation as a whole. These
are simple choices such as fading from black to the screen and so on, and it is worth using
our basic slide – or more than one – and having a look at the different options available.
The basic features of PowerPoint are well known to those who use them and are useful in
many ways, as with those mentioned above – and many others – there are also the standard
options of spelling and grammar checking and the selection of fonts, colors, borders and
margins, and more. Having looked at some of the basic features, it is now time to advance a
little further to take in some of the more intricate functions that PowerPoint can offer.

Chapter 2: Advance Features
As we have shown there is a great deal of versatility to be found when using the simplest
features of the PowerPoint package, yet many people are prone to tap into only a small
amount of the capacity of the program. In looking at more advanced features of PowerPoint
we can see how a new world of presentation options can be accessed, and all quite easily with
just a little bit of practice.
Let’s start by looking at the slide show facility, one of the primary functions of the
PowerPoint package and a useful feature that is used by many.
Slide Show:
To create a slide show we need to create some slides; follow the instructions above and create
a simple title page – as offered when the program is opened – then select the ‘New Slide’
option from the menu at the top. The new slide will be presented on the screen as a blank
slide and also at the left hand side of the page; if you highlight the impression on the left,
with one click, and then select the ‘Layout’ button on the menu you will be presented with a
selection of possible page layouts – as shown below:

This is another example of the versatility of PowerPoint, for it gives you the option of several
different possible layouts that cover just about every incidence you may need. For the
purpose of our demonstration select the ‘Title and Content’ option. Now enter a title –
anything will do in this instance – and in the middle of the main box you will see a collection
of icons.

These are for you to choose what you want to insert into the space, and you can choose from
a table, a chart, SmartArt graphics, pictures from your folders, clip art of a media clip (sound
or audio). Select pictures, and you will be sent to your pictures library to recover a picture for
use.
Your slide now looks like this, with your picture substituted for mine:

We now have two slides, and from this we can create a slide show. The method is very
simple, and is one that you will use many times once you have mastered the art of slide show
creation.
Simply select the ‘Slide Show’ tab at the top of the screen and have a look at the options
provided. If you select the first option on the left – ‘From Beginning’ – you will be given a
preview of the slides you have created as a slide show. Try it, and see what happens.
In the first instance you will be presented with a full screen shot of the title page you created.
One click when this is displayed and you will see the screen switch to the second slide, the
one in which you have inserted a picture. This is the simplest form of slide show, one
controlled and created by the user manually.
Now we want to set the slide show to display itself, and this is where we get into the scenario
in which timings are used.
Using Timings
Although at first glance the timings function appears to be complex it is actually simple to
use; to get an idea of what it is all about we need to understand what it is going to do for us.
Basically, when we set timings we are allowing the slide show to present itself. This is a

major bonus for those who are presenting a lengthy or repeated slide show, and it is used in
many instances of academic and business presentations to great effect.
One thing we do need to decide is whether our slide show is going to be shown on a loop or
whether it is going to be shown just once and then come to an end. In the box to the right of
the one we have looked at so far – the one titled, underneath, ‘Set Up’ – we see a number of
options. Among these is one that states Set up slide show’. This is perhaps the most important
of all PowerPoint tabs, and one that defines the way the slide show will be presented and
viewed. If you select this tab you will be given a screen that looks like this:

This is the screen that you will use to program your slide show to do as you wish. Starting at
the top we see the option of ‘Presented by a speaker’; this is the one we are going to use as
for the purpose of this demo we are assuming our presentation is being given by you. The
other options are for slide shows that users click through individually.
Select the ‘presented by a speaker option’ to begin with. Beneath these options we have a
selection that defines how the slide show will be presented; if we were to select the ‘loop
continuously’ option our slide show will continue to display at the timings we are about to set
until we press the escape button. Let’s de-select this option for the purpose of this
demonstration.
In order to see what we have done so far go back to the beginning and select the ‘begin slide
show’ button at the top left; you will be presented with your first slide, and on clicking you
will be presented with your second. Click again and you will go back to the opening slide,
and so on until you click escape and return to the set up screen.
Back at the set up screen change the selection (on the right) from ‘Manually’ to ‘Using
timings’. Now we have to determine how long our slides are to display for. This, again, is a
simple process that takes little getting used to.

Return to the main menu and select the button that indicates ‘rehearse timings’; you will
immediately be given your opening slide with a clock counting in the top left corner. When
your slide has been displayed for long enough press enter, and repeat for the second slide.
Exit, and select – from the main menu – ‘from beginning’ – and watch what happens.
Your first slide will be visible for as long as you selected, and your second slide then follows;
after this a blank screen is presented with the escape instruction.
Using Narration
To record narration for your slide show you will need a microphone, but beyond that it is a
simple and straightforward process. Selecting the ‘record narration’ option gives you the
screen that you use to set up the recording, and this is where the ‘rehearse timing’ option is
given its full scope.
Running your slide show a handful of times with a script in front of you is a way of getting
your words co-ordinated with your visuals, and when you are certain you have it right you
can simply record your audio clip and save it. When it comes to inserting it you do so using
the same method we used for inserting a picture.
The beauty of using narration and also in using moving pictures – video is also an option – is
in the way it brings a presentation alive, and those who are not great public speakers need
only record a message once for use over and over again.

Chapter 3: Using Templates
When creating slideshows for PowerPoint presentations you will rarely use the very basic
introductory slides that we have used for our demonstration, largely thanks to the number of
already installed templates that are available for your use. These are time served designs that
offer a wealth of different opportunities and styles, and also a great deal of diversity as a
result. It is possible and often sensible to create your own unique templates, and many choose
to do so, but it is also worth having a look at the number of useful templates presented with
the PowerPoint package. Let’s have a look at a few, and how to use them.
The simple way to have a look at the templates function is to follow these steps:
1: Open Microsoft PowerPoint in Office 10.
2: Click on the Office Button, the circular icon in the top left hand corner of the screen.
3: Select ‘new’ and you will see the following screen.

Now select the ‘Installed Templates’ option and have a look at what is displayed. There are a
number of different templates on display that will give you a good idea of the options
available, and one of the most popular is the ‘classic photo album’ template. Select this one
and have a look at what it offers.
You will see that it gives you a selection of different pages down the left hand side, each of
which offers a position for a photograph – or several – from your collection and places for

text and captions that you may wish to enter. Each page, before you manipulate it, includes
useful information about how to use that particular frame. This is a neat way of presenting a
photo album, and one that is often used to good effect.
Additionally there are many categories listed on the left of the screen that offer different
varieties of forms and documents. These are available from the Microsoft Office Online
selection and the choice is as comprehensive as can be; select one, any for a demonstration,
and you will see again a number of options offered, each of which is different in style and
format. With everything from calendars through to agendas – useful for business
presentations - there is much to choose from making this a useful and easy to use tool that
offers great versatility.
In fact, the ‘Agenda’s’ option is of particular use and clicking on it will download a variety of
options that may be of interest to you. Many meetings that are powered by a PowerPoint
presentation are guided by well presented agendas, and the options on offer in this section are
both interesting and varied, meaning that you can choose your own style. Have a look at
some of the agenda’s on offer – you will be surprised by the variety available. Take a look
also at the ‘Content Slides’ selection, as this is an area that has provided much inspiration for
those creating slides in the past. Making an impact is always part and parcel of a presentation,
and some of the images available are attention grabbing in a number of different ways.
Useful templates in this section include the timer screens, these being images that count down
from a given time and then begin the presentation itself. Notably, they also come with full
instructions on their use when downloaded, another neat touch that is typical of PowerPoint.
All of the available templates can be edited to your requirements, and when you save you can
send it to the My Templates section for ease of use, thus building up your own collection of
standard templates to your required designs.
Opening a blank template from the selection allows you to create custom templates using the
many features already described, yet the presence of such a wide selection of already present
templates is a bonus that is difficult to overlook.
There is also an official Microsoft selection of templates, with some that are created by other
users who wish to share them, at http//:office.com/templates and here you can browse
through a wealth of designs and find one that suits your needs.

Chapter 4: Microsoft Office Web App
Among the most talked about aspects of the Office 10 package is the Web Apps function, a
system that allows PowerPoint – and other – worksheets and documents to be opened and
edited using the computers browser. The advantages of this are increased versatility and the
ability to work on documents from anywhere, and the system has met with much acclaim
among users of the new package.
Using the system present you can publish to the browser from the desktop – a useful function
that will be welcomed by many – and can specify those who are able to open and edit the
document, thus giving added protection, while the look and feel of the document is somewhat
more web-friendly than that of the desktop variety.
The prospect for sharing of data and presentations is much brighter with this system. Using
the Office Live Workspace feature it is possible to open a slide and amend, marking the
amendments and then sharing with another user. A neat touch is that whoever opens the slide
first is the one ‘in control’ of the changes that can be made to that particular worksheet. In
addition, Microsoft SharedView is an alternative system whereby you can edit and view edits
made by others in real time, a truly live system that allows you to control, as above, who can
view and edit slides and to see what others are doing as they carry out their amendments.
Bringing Office 10 to the web has allowed for an increase in the overall versatility of the
system, and is a step forward in eliminating the need for desktop documents to be sent
between users.
The system is simple to use; simply open – or create – a slide and click the File tab. This
gives you the standard backstage options, among which you should select Share and then
Save to SkyDrive. This is a free storage system that is part of the Office Live package and is
very useful. Next you need to sign in using your Windows Live ID– if you don’t already have
one the option is there to create one– and select the document required from the SkyDrive list
that is displayed.
If you now click View you will, after accepting terms of use, be able to edit, share or publish
your slide online.
However, as has been reported and commented on, the Web Apps version of a document has
certain limitations; there are many functions that you can amend, add and delete in the
desktop version that you cannot on the web version, hence any in depth or serious editing will
have to be done off line and the process repeated. However, this is very simple – with a
document open in the browser you simply click the Open command and it will automatically
open in the desktop version of PowerPoint; similarly, saving it returns you to the point you
were at before.
Perhaps the most useful aspect of the new web based version of PowerPoint is in the way it
can be used in real time by many people to view a slide show presentation. This is a great

way of enabling remote conferencing and has many possibilities and a great deal of scope.
Easy to use and versatile, PowerPoint is much improved by the introduction of the new
Office 10 version.
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